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使用上の注意 

安全に正しくお使いいただくために必ずお守りください。 

[使用環境・使用方法] 
 
 

 
高温多湿の場所、塵埃の多い場所や振動のある場所に設置しないでください。使用条
件以外の環境でのご使用は、動作の異常、火災や感電の原因になることがあります。

[運搬・移動]  
 
 

 

運搬時などに外部から強い衝撃を与えないように注意してください。機器が故障す
ることがあります。機器を他の場所へ移動するときは、専用の梱包材をご使用くだ
さい。 

[内部の設定変更が必要なとき] 
 
 

 
電源を切ってから、設定変更の操作を行ってください。電源を入れた状態で設定が必要
な場合は、サービス技術者が行ってください。 

 
 

 
過熱部分には触らないでください。やけどをする恐れがあります。 

[異常時の処置] 
 
 

 

電源が入らない、異臭がする、異常な音が聞こえるときは、内部に異常が発生している
恐れがあります。すぐに電源を切り、販売代理店、サービスセンターまでご連絡くださ
い。 

[消耗部品] 
 
 
 
 

消耗部品が使用されている機器では、定期的に消耗部品を交換してください。消耗部
品・交換期間の詳しい内容については、取扱説明書の最後にある仕様でご確認くださ
い。なお、消耗部品は使用環境で寿命が大きく変わりますので、早めの交換をお願いい
たします。消耗部品の交換については、販売代理店へお問い合わせください。 

 

 

必ず行う 

必ず行う 

触らない 

注意 

禁止 

注意 



 

 

開梱および確認 
このたびは、UFM-30DCC デジタルカラーコレクタをお買い上げ頂きまして、誠にありがとうご

ざいます。本製品を正しくご使用して頂くために、この取扱説明書をよくお読みください。また、

本書はお読みになった後も大切に保管してください。 
 

 構成表 
品   名 数 量 備      考 

UFM-30DCC 1 セット 
フロントモジュール 
リアモジュール 

取扱説明書 1 （本書） 
 

 オプション 
品   名 数 量 備      考 

UFM-3DCC2C 1 デュアルチャネルオプション(ソフトウェア) 

UFM-3DCC3G 1 3G-SDI オプション 

DCC-OUA 1 オペレーションユニット(RS422 タイプ) 

DCC-NETOU 1 オペレーションユニット(イーサネットタイプ) 

コントロールケーブル 1 DCC-OUA 接続用（PC-2076-3） 

UFM-30CTL 1 WEB 制御･DCC-NETOU 制御 UFM モジュール 
 

本製品は、ユニバーサルフレーム UF-106A、UF-106B および UF-112 に実装可能です。 

UF-106 には実装できません。 

UF-106A は最大 4 枚まで実装可能です。(UF-106APS 使用時は最大 2 枚まで実装可能) 

UF-106B は最大 6 枚まで実装可能です。(UF-106BPS 使用時は最大 4 枚まで実装可能) 
 

注意 
UF-106A に UFM-30DCC/UFM-3DCC2C を組み込むには使用できるスロットに

制限があります。スロット 2、4、5、6 に実装が可能です。スロット 1、3 には

実装できません。スロット番号は UF-106A の取扱説明書を参照してください。

 

UFM-30DCC の操作には、DCC-OUA、DCC-NETOU または UFM-30CTL (WEB 制御)

が必要です。DCC-OUA 使用時には専用のコントロールケーブル（PC-2076-3）が必

要です。DCC-NETOU の接続には UFM-30CTL が必要です。 

また、1 台の UFM-30DCC を DCC-OUA と DCC-NETOU から同時制御することはで

きません。 

 

DCC-OUA をご使用になる前に、DCC-OUA のバージョンが 2.00 以上、取扱説明書が

2nd Edition 以上であることを確認してください。また、デュアルチャネルモードを使

用する場合は、DCC-OUA のバージョンが 3.00 以上、取扱説明書が 3rd Edition 以上

であることを確認してください。DCC-OUA のバージョンの確認方法については

「DCC-OUA 取扱説明書」を参照してください。もし、バージョンが異なる場合は担

当営業、または販売代理店までご連絡ください 

旧製品のオペレーションユニット DCC-OU から UFM-30DCC を制御することはでき

ますが、いくつかの機能が操作できませんので注意してください。（「3-1-2」参照） 

 

確認 

もし、品物に損傷があった場合は、直ちに運送業者にご連絡ください。品物に不足があった

場合や、品物が間違っている場合は、販売代理店までご連絡ください。 



 

 

目次 
1. 概要および特長 ...................................................................................................................................... 1 

1-1. 概要 .................................................................................................................................................. 1 
1-2. 特長 .................................................................................................................................................. 1 

2. 各部の名称と機能 .................................................................................................................................. 2 
2-1. 前面パネル ...................................................................................................................................... 2 
2-2. 背面パネル ...................................................................................................................................... 2 

3. 接続 .......................................................................................................................................................... 3 
3-1. DCC-OUA との接続 ........................................................................................................................ 3 

3-1-1. REMOTE コネクタ .................................................................................................................. 4 
3-1-2. 旧製品 DCC-OU の使用について .......................................................................................... 4 

3-2. WEB ブラウザとの接続 .................................................................................................................. 5 
3-3. DCC-NETOU の接続 ....................................................................................................................... 6 
3-4. 電源を入れる................................................................................................................................... 7 

3-4-1. UF-106A、UF-106B に実装した場合 ..................................................................................... 7 
3-4-2. UF-112 に実装した場合 ........................................................................................................... 7 

3-5. メニュー操作................................................................................................................................... 8 
3-6. DCC-OUA 制御と WEB ブラウザ制御 .......................................................................................... 9 

3-6-1. DCC-OUA (Ver. 2.00 以上) 制御 ............................................................................................ 9 
3-6-2. WEB ブラウザ制御 .................................................................................................................. 9 
3-6-3. DCC-OUA 操作と WEB ブラウザ操作の違い .................................................................... 10 

4. DCC-OUA 使用時 .................................................................................................................................. 11 
4-1. UFM-30DCC 前面パネルメニューリスト ................................................................................... 11 

4-1-1. カラーコレクタ 1 チャネル構成 ......................................................................................... 11 
4-1-1-1. 標準構成 1 チャネルのメニュー ................................................................................. 11 

4-1-2. カラーコレクタ 2 チャネル構成 (UFM-3DCC2C オプション) ....................................... 12 
4-1-2-1. モード選択 ..................................................................................................................... 12 
4-1-2-2. Single Channel モードのメニュー ................................................................................ 12 
4-1-2-3. Dual Channel モードのメニュー ................................................................................... 13 
4-1-2-4. Link モードのメニュー .................................................................................................. 14 

4-2. UFM-30DCC 前面パネルメニュー詳細....................................................................................... 15 
4-2-1. カラーコレクタ (チャネル) 選択 ...................................................................................... 15 
4-2-2. システム設定 ......................................................................................................................... 15 
4-2-3. システムステータス（表示のみ） ..................................................................................... 17 
4-2-4. モジュール情報（表示のみ） ............................................................................................. 17 

5. WEB ブラウザ使用時 ........................................................................................................................... 18 
5-1. UFM-30DCC 前面パネルメニューリスト ................................................................................... 18 

5-1-1. カラーコレクタ 1 チャネル構成 ......................................................................................... 18 
5-1-1-1. 標準構成 1 チャネルのメニュー ................................................................................. 18 

5-1-2. カラーコレクタ 2 チャネル構成 (UFM-3DCC2C オプション) ....................................... 21 
5-1-2-1. モード選択 ..................................................................................................................... 21 
5-1-2-2. Single Channel モードメニュー ..................................................................................... 21 
5-1-2-3. Dual Channel モードメニュー ....................................................................................... 21 
5-1-2-4. Link モードメニュー ...................................................................................................... 23 

5-2. UFM-30DCC 前面パネルメニュー詳細....................................................................................... 25 
5-2-1. カラーコレクタ (チャネル) 選択 ...................................................................................... 25 



 

 

5-2-2. プロセスアンプ ..................................................................................................................... 25 
5-2-3. カラーコレクション ............................................................................................................. 25 
5-2-4. クリップコントロール ......................................................................................................... 27 
5-2-5. システム設定 ......................................................................................................................... 30 
5-2-6. イベントメモリ ..................................................................................................................... 32 

5-2-6-1. VID FRMT (VIDEO FORMAT) イベントメモリについて ........................................ 34 
5-2-7. 前面パネル設定 ..................................................................................................................... 35 
5-2-8. システムステータス（表示のみ） ..................................................................................... 35 
5-2-9. モジュール情報（表示のみ） ............................................................................................. 35 

6. 内部設定 ................................................................................................................................................ 36 
6-1. ディップスイッチ S3 .................................................................................................................... 36 

6-1-1. DCC-OUA/WEB 制御切り換え (S3-1) ................................................................................. 36 
6-1-2. 初期化方法 (S3-6) ................................................................................................................. 36 
6-1-3. 処理モードの切り換え(S3-3) ............................................................................................... 37 

6-2. ジャンパ JP3 .................................................................................................................................. 38 
6-2-1. DCC-OUA/WEB 制御切り換え ............................................................................................. 38 

7. トラブルシューティング .................................................................................................................... 39 

8. 仕様および外観図 ................................................................................................................................ 40 
8-1. 仕様 ................................................................................................................................................. 40 
8-2. 外観図 ............................................................................................................................................. 42 

 

 



 

1 

1. 概要および特長 

1-1. 概要 

UFM-30DCC は、UF-106A、UF-106B 及び UF-112 フレームに組み込んで使用するプラグイ

ンモジュールです。HD/SD-SDI 対応のデジタルカラーコレクタとして、最新のデジタル技

術を応用して開発されました。オペレーションユニット、WEB 制御、ネットワークオペレ

ーションユニットの 3 種類のコントローラが選択できます。 

 

 

1-2. 特長 

 HD/SD SDI の 6 フォーマットに対応 

 標準構成時：映像 2 入力 (メニュー選択) ／カラーコレクション 1 チャネル／2 出力  

 UFM-3DCC2C 実装時：映像 2 入力／カラーコレクション 2 チャネル／2 出力  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 3 種類のオペレーションモード (メニュー切換) 

Single Channel モード： カラーコレクタ 1 チャネル 2 出力 

Dual Channel モード： カラーコレクタ 2 チャネル各 1 出力 (個別設定) (オプション) 

Link モード：  カラーコレクタ 2 チャネル各 1 出力 (共通設定) (オプション) 

 DCC-OUA 制御または WEB ブラウザ制御を選択 (内部設定) 

 豊富なカラーコレクタ機能 

 プロセスコントロール 

 カラーコレクション (WHITE／BLACK／GAMMA) 

3 種類のカラーコレクションモード (メニュー切換) 

GBR 処理のバランスモード 

YPbPr 処理のディファレンシャルモード 

モノトーンの画作りに有効なセピアモード 

 YPbPr クリップ、GBR クリップ、コンポジットクリップ 

 バイパス機能 

 H/V アンシラリデータの通過／削除 

HD/SD-SDI IN1 
Serial to
Parallel

Select
2:1 

Serial to
Parallel

Parallel
to Serial

Color 
Corrector

HD/SD-SDI IN2 

HD/SD-SDI OUT 1 

HD/SD-SDI OUT 2 

RS-422 

標準構成（1 チャネル）

HD/SD-SDI OUT 2 

HD/SD-SDI IN1 
Serial to
Parallel

Color 
Corrector

 
2-channel

or 
Link 

Serial to
Parallel

Parallel
to Serial

Parallel
to SerialHD/SD-SDI IN2 

HD/SD-SDI OUT1

RS-422 

UFM-3DCC2C 実装時（2 チャネル）
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2. 各部の名称と機能 

2-1. 前面パネル 

 

 

 

 

 

 

 
番号 名前 内容 

(1) INPUT LED 
点灯：信号が正常に入力されています。 
消灯：信号が入力されていません。 
オペレーションモードにより動作が変わります。（下表参照） 

(2) POWER LED 電源が投入されると点灯します。 

(3) 上下スイッチ メニュー項目の移動に使用します。（「3-5. メニュー操作」参
照） 

(4) LED ディスプレイ 各種設定の項目、パラメータを表示します。 

(5) メニュー 
コントロール 

メニュー項目の移動、設定に使用します。（「3-5. メニュー操
作」参照） 

(6) 
UNITY/表示切換 
ボタン 

メニュー項目の初期値と現在の値の切り換えを行います。 
メニュー番号・項目の表示時は、詳細表示・略称表示の切り換え
を行います。 

 

 INPUT LED 
Operation Mode LED 内容 

Single Channel 
モード 

点灯 選択されたチャネルに信号が正常に入力されています。 

消灯 選択されたチャネルに信号が入力されていません。 

Dual Channel 
モード 

点灯 チャネル 1、2 のいずれかまたは両方に信号が正常に入力されて
います。 

消灯 チャネル 1、2 ともに信号が入力されていません。 

Link モード 
点灯 チャネル 1、2 ともに信号が正常に入力されています。 

消灯 チャネル 1、2 のいずれかまたは両方に信号が入力されていませ
ん。 

 

 

2-2. 背面パネル 

 

 

 

 

 

 
番号 名前 内容 

(1) HD/SD-SDI IN 1, 2 HD/SD-SDI 信号の入力端子です。 

(2) HD/SD-SDI OUT 1, 2 HD/SD-SDI 信号の出力端子です。 

(3) REMOTE DCC-OUA と接続します。 

 

(5) 

(6) 
(1) 

(2) 

(3) (4) 

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT

(3)

S
/N

o
.

UFM-30DCCHD/SD-SDI OUT

21

HD/SD-SDI IN

1 2

REMOTE

(1) (2)
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3. 接続 
本製品は UF-106A、UF-106B および UF-112 へ組込むことが可能です。下図の例を参照して

周辺機器との接続を行ってください。 

UF-106A、UF-106B および UF-112 への組み込み方法については、それぞれの取扱説明書を

参照してください。 

注意 接続は全ての機器の電源が切れている状態で行ってください。 

 

3-1. DCC-OUA との接続 

DCC-OUA との接続には別途専用の接続ケーブル（PC-2076-3）が必要です。REMOTE コネ

クタを使用して接続します。詳しくは「DCC-OUA 取扱説明書（2nd Edition 以降）」を参照

してください。 

 

 例 UF-112 背面パネル: UFM-30DCC 

 標準構成 (1 チャネル) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 オプション構成 (2 チャネル) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

UF-112 

R
A

T
IN

G
 L

A
B

E
L

G
E

N
L

O
C

K
 I

N
A

L
A

R
M

A
C

1
0

0-
2

4
0V

 ~
 5

0
/6

0H
z 

IN

F
A

N
A

L
M

UFM-30DCC

HD/SD OUT 1 

HD/SD OUT 2 

HD/SD SDI IN2

HD/SD SDI IN1

RATING LABEL
OFF

PU SH

ESUFPOWER

ON

TO MU4TO MU3TO MU2TO MU1

AC100-117V ~ 50/60Hz IN

S
/N

o
.

UFM-30DCCHD/SD-SDI OUT

21

HD/SD-SDI IN

1 2

REMOTE

接続ケーブル

DCC-OUA 

UF-112 

R
A

T
IN

G
 L

A
B

E
L

G
E

N
L

O
C

K
 I

N
A

L
A

R
M

A
C

1
0

0-
2

4
0V

 ~
 5

0
/6

0H
z 

IN

F
A

N
A

L
M

UFM-30DCC

HD/SD OUT1 （チャネル 1 出力） 

HD/SD OUT2 （チャネル 2 出力） 

HD/SD SDI IN2

HD/SD SDI IN1

S
/N

o.

UFM-30DCCHD/SD-SDI OUT

21

HD/SD-SDI IN

1 2

REMOTE

接続ケーブル

RATING LABEL
OFF

PU SH

ESUFPOWER

ON

TO MU4TO MU3TO MU2TO MU1

AC100-117V ~ 50/60Hz IN
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3-1-1. REMOTE コネクタ 

 コネクタ 

D-sub 9 ピン、メス（インチネジ使用） 

 

 

 

 

 

 

 端子配列表（D-sub 9 ピン メス） 
ピン番号 信号名 信号内容 

1 Reserved 未使用 

2 TX (-) TRANSMIT- 

3 RX (+) RECEIVE+ 

4 ― ― 

5 ― ― 

6 ― ― 

7 TX (+) TRANSMIT+ 

8 RX (-) RECEIVE- 

9 FG フレームグランド 

 

 

3-1-2. 旧製品 DCC-OU の使用について 

DCC-OU を UFM-30DCC に接続して使用した場合下記の機能設定はできません。 

 

・SPLIT 機能設定 

・GAMMA Curve 設定 

・GBR クリップ設定 

・コンポジットクリップ設定 

 

UFM-30DCC が Single Channel モード時のみ使用できます。 
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3-2. WEB ブラウザとの接続 

UFM-30DCC は UFM-30CTL とイーサネットで接続された PC 上で WEB ブラウザから制御

します。UFM-30CTL と PC との接続について、詳しくは「UFM-30CTL 取扱説明書」を参照

してください。 

 

 例 UF-112 背面パネル: UFM-30DCC + UFM-30CTL 

 標準構成 (1 チャネル) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 拡張構成 (2 チャネル) 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

UFM-30CTL 

HD/SD OUT 1

HD/SD OUT 2

HD/SD SDI IN2 

HD/SD SDI IN1 
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L
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N

R
S
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1
2

S
/N

o
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UFM-30DCCHD/SD-SDI OUT

21

HD/SD-SDI IN

1 2

REMOTE

PC 

UF-112 
UFM-30DCC 

イーサネット 

ハブ

UFM-30CTL 

HD/SD OUT1 （チャネル 1 出力）

HD/SD OUT2 （チャネル 2 出力）

HD/SD SDI IN2 

HD/SD SDI IN1 

R
A

T
IN

G
 L

A
B

E
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G
E

N
L

O
C

K
 I

N
A

L
A

R
M
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C
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0
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R
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S
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o
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UFM-30DCCHD/SD-SDI OUT
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HD/SD-SDI IN

1 2

REMOTE

PC 

UF-112 
UFM-30DCC 

イーサネット 

ハブ



 

6 

3-3. DCC-NETOU の接続 

UFM-30DCC は UFM-30CTL とイーサネットで接続された DCC-NETOU から制御します。

UFM-30CTL と DCC-NETOU との接続について、詳しくは「DCC-NETOU 取扱説明書」を参

照してください。 

 

 例 UF-112 背面パネル：UFM-30DCC + UFM30CTL 

 標準構成 (1 チャネル) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 拡張構成 (2 チャネル) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

UFM-30CTL 

HD/SD OUT 1
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RATING LABEL

DCC-NETOU
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3-4. 電源を入れる 

3-4-1. UF-106A、UF-106B に実装した場合 

 例 UF-106B 

1) 左右のネジを緩めて手前に引き、UF-106B の前面パネルを開けます。 

 
 

 

 

 

 

2) 全ての機器が正しく接続されたのを確認して、電源スイッチを ON にします。 

 

 

 

 

 

3-4-2. UF-112 に実装した場合 

1） 左右のネジを緩めて手前に引き、UF-112 の前面パネルを開けます。 

 

 

 

 

 

 

 

 

 

 

 

2） 全ての機器が正しく接続されたのを確認して、UFM フレームの電源を ON にします。起

動が完了すると、下図のように『UFM30DCC』と前面パネルに表示されます。ビデオ信

号、電源が入力されていると、INPUT、POWER ランプがそれぞれ緑に点灯します。 

 

 

 

 

 

 

 

 

 

 

 

 

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUTINPUT LED 

POWER LED 

U F M 3 0 D C C

OFF

POWER

TEMP

FAN

ALARM

DC
POWER

POWER

GENLOCK
INON

POWER スイッチ 

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT

UNIVERSAL FRAME

ALARM

POWER 2

ALARM

POWER 1

FAN

TEMP TEMP

GENLOCK IN

POWER POWER

GENLOCK IN

FAN

DC POW DC POW

UF-112

POWER
FAN TEMP DC POW

ALARM
GENLK IN

POWER

POWER 1 POWER 2GENLK IN
ALARM

DC POWTEMPFAN
(OPTION)

UF-106B
UNIVERSAL FRAME

ON

POWER

ALARM

REF
IN

DC
POWER

TEMP

OFF

POWER FAN

ON

POWER

ALARM

REF
IN

DC
POWER

TEMP

OFF

POWER FAN

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT
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3-5. メニュー操作 

1) コントロールを回して、設定したい項目をディスプレイに表示します。 

 

 

 

 

I N S E L ＞

 

2) コントロールを押すと､その項目の設定値が表示されます。 

 

 

 

 

S D I I n 1

 

3) コントロールを回して値を変更します。 

4) コントロールを押して変更を確定します。メニューが表示モードへ戻ります。 

 

 

 

 

I N S E L ＞

 

1)～4)の操作を行い、必要な項目を全て設定します。 

 

 カテゴリ間を移動する 

上下スイッチを使用すると、System Setup、System Status、Module Information などのカ

テゴリ単位でメニュー間を移動することができます。 

 

 メニューカテゴリ内の設定を表示する 

カテゴリ名を表示し UNITY ボタンを押します。画面上で、カテゴリ内のメニュー項目

の設定が横にスクロールしながら次々と表示されます。 

 

 初期値に戻す 

メニュー項目を表示し、UNITY ボタンを押します。その項目の値が初期値に戻ります。 

 

 値を元に戻す 

コントロールを回して値を変更した後で前の値に戻したいときは（コントロールを押す

と元に戻せません）、上下スイッチを上へ動かします。再び変更した値にするときは上

下スイッチを下へ動かします。コントロールを押すと表示されている値に確定されます。 

 

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT
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3-6. DCC-OUA 制御と WEB ブラウザ制御 

UFM-30DCC は、DCC-OUA または、UFM-30CTL と組み合わせて LAN 経由にて PC 上の

WEB ブラウザおよび DCC-NETOU から操作します。DCC-OUA／WEB ブラウザ操作の切り

換えは、基板内部のディップスイッチとジャンパで行います。初期設定は DCC-OUA による

操作です。（「6. 内部設定」） 

DCC-OUA と接続するか WEB ブラウザと接続するかにより、UFM-30DCC の前面パネルで

操作できるメニューが異なります。詳しくは次のページを参照してください。 

 

 

3-6-1. DCC-OUA (Ver. 2.00 以上) 制御 

VIDEO メニュー（プロセスアンプ、カラーコレクション、スプリットモード、ビデオ

クリップ設定）および UTILITY メニュー（イベント等）は UFM-30DCC 上では設定／

表示できません。DCC-OUA から操作します。入力信号の選択は DCC-OUA からはでき

ません。（DCC-OUA の操作については「DCC-OUA 取扱説明書」を参照) 

 

 

 

 

 

 

 

 

 

 

3-6-2. WEB ブラウザ制御 

UFM-30DCC および WEB ブラウザでは、ほぼ同じメニューを設定／表示できます。 

 

 

 

 

 

 

 

 

 

UF フレーム

UFM-30DCC

DCC-OUA（V2.00 以上） VIDEO メニュー 
UTILITY メニュー 
Bypass/Operate 設定

SYSTEM メニュー 
STATUS メニュー 

UF フレーム

UFM-30DCC

WEB
ブラウザ 

VIDEO メニュー 
SYSTEM メニュー 
UTILITY メニュー 
STATUS メニュー 

VIDEO メニュー 
SYSTEM メニュー 
UTILITY メニュー 
STATUS メニュー UFM-30CTL
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3-6-3. DCC-OUA 操作と WEB ブラウザ操作の違い 

UFM-30DCC を DCC-OUA と組み合わせて使用する場合は、カラーコレクション機能は

DCC-OUA で操作し、システム設定などは UFM-30DCC で行います。 

UFM-30DCC を WEB ブラウザと接続して使用する場合は、UFM-30DCC 上、WEB ブラ

ウザ上でほぼ同じ操作ができます。下記の表はコントローラと操作可能な主な項目のリ

ストです。 

 

操作方法 UFM-30DCC + DCC-OUA 
UFM-30DCC + WEB ブラウザおよび 

DCC-NETOU 

コントローラ 
操作項目 

UFM-30DCC
(前面パネル) DCC-OUA UFM-30DCC 

(前面パネル) 
WEB 

ブラウザ 
DCC- 

NETOU 

Input Select ○ × ○ ○ ○ 

Bypass/Operate × ○ ○ ○ ○ 

Loss Mode ○ × ○ ○ × 

Back Color ○ × ○ ○ × 

H/V Ancillary Mode ○ × ○ ○ × 

Output Delay ○ × ○ ○ × 

Test Signal ○ × ○ ○ × 

Operation Mode 
(Single/Dual/Link) ○ × ○ ○ × 

      

Panel Lock ○ × ○ × × 

Start Up Event Load × × ○ ○ × 

Auto Event Load × × ○ ○ × 

Event Load/Event Save × ○ ○ ○ ○ 

Clip Event Load/ 
Clip Event Save × ○ × × × 

Save File × × × ○ × 

Restore × × × ○ × 

      

カラーコレクタチャネル
1、2 の選択 ○ ○ ○ ○ ○ 

プロセスアンプ機能 × ○ ○ ○ ○ 

カラーコレクション機能 × ○ ○ ○ ○ 

スプリットモード選択 × ○ ○ ○ ○ 

ビデオクリップ機能 × ○ ○ ○ ○ 

○：設定可能 

×：設定不可 

 

UFM-30DCC の前面パネルから操作可能な項目については、この後の章を参照してくだ

さい。DCC-OUA からの操作については「DCC-OUA 取扱説明書」を参照してください。

WEB ブラウザからの操作については「UFM-30CTL 取扱説明書」を参照してください。 

 

DCC-NETOU から UFM-30DCC を操作する場合に UFM-30DCC の前面パネルから操作可

能な項目は、WEB ブラウザ操作時と同じになります。DCC-NETOU からの操作について

は「DCC-NETOU 取扱説明書」を参照してください。 
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4. DCC-OUA 使用時 

4-1. UFM-30DCC 前面パネルメニューリスト 

4-1-1. カラーコレクタ 1 チャネル構成 

入力 1 選択時 

 

 

 

 

 

入力 2 選択時 

 

 

 

 

 

 

4-1-1-1. 標準構成 1 チャネルのメニュー 

メニュー分類 設定内容概略 

SYSTEM 入力ビデオの選択、信号ロス時の動作、アンシラリデータ処理等を設定し
ます。 

STATUS ビデオ信号、基板の状態についてのデータを表示します。 

 

分類 
メニュー 

参照 
番号 項目 略称表示 

SYSTEM 1  System Setup System 4-2-2 

  1-1 
1-2 
1-3 
1-4 
1-5 
1-6 
1-9 
1-11
1-12

Input Select>  
Loss Mode> 
Back Color> 
H Ancillary Mode 
V Ancillary Mode 
Output Delay>  
Test Signal> 
Front Brightness> 
Panel Lock> 

IN SEL> 
LossMOD> 
BColor> 
H ANCI> 
V ANCI> 
Out DLY> 
TESTSIG> 
Bright> 
Lock > 

 
 

STATUS 2  System Status SYSTMSTS 4-2-3 

  2-1 
2-2 
2-3 

Selected SDI Input>  
SDI IN1 Format> 
SDI IN2 Format> 

SEL IN> 
IN1 STS> 
IN2 STS> 

 

 3  Module Information MDL INFO 4-2-4 

  3-1 
3-2 
3-3 
3-4 
3-5 
3-6 

External Control Mode> 
Version Info> 
FPGA Version Info> 
UFM-3DCC2C Option Info> 
UFM-3DCCMF Option Info> 
UFM-3DCC3G Option Info> 

CTL Mod> 
Version> 
FPGA> 
Dual Ch> 
Multi> 
3G Op> 

 

 

UFM-30DCC

入力 1

入力 2

カラーコレクタ 1
設定 1 

出力 1 

出力 2 

UFM-30DCC

入力 1

入力 2

カラーコレクタ 1
設定 1 

出力 1 

出力 2 
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4-1-2. カラーコレクタ 2 チャネル構成 (UFM-3DCC2C オプション) 

4-1-2-1. モード選択 

2 チャネル構成時は、Single Channel モード、2 系統の入力を個別の設定で処理する Dual 

Channel モード、2 系統の入力を同じ設定で処理する Link モードの 3 つのモードを使

用できます。 

 

1) コントロールを回して、OP Mode>をディスプレイに表示します。 

 

 

 

 

 

O P M o d e ＞

 

2) コントロールを押します。初期設定は Dual Channel モード (Dual) です 

 

 

 

 

 

D u a l  

 

3) コントロールを回し、Single、Dual、Link からモードを選択します。コントロール

を押します。 

 

 

 

 

 

L i n k  ＞

 

注意 

Single Channel モードの設定、Link モードの設定、および Dual Channel モ

ードの「設定 1」は共通です。カラーコレクション等の設定変更後にオペ

レーションモードを変更すると、変更後の設定が適用されますので注意し

てください。設定を戻したい場合は、イベントに保存しておき読み込んで

ください。 

 

 

4-1-2-2. Single Channel モードのメニュー 

2 チャネル構成時の Single Channel モードのメニューは、標準構成 1 チャネルのメニュ

ーとほとんど同じです。「1-10 Operation Mode」を設定できるところだけが異なりま

す。「4-1-1. カラーコレクタ 1 チャネル構成」を参照してください。 

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT
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4-1-2-3. Dual Channel モードのメニュー 

Dual Channel モードでは、2 つのカラーコレクタを個別設定で使用できます。まず Select 

Color Corrector 1 or 2 項目でチャネルを選択してから設定を行ってください。 

 

 

 

 

 

 

 

 
メニュー分類 設定内容概略 

DUAL 設定を行うカラーコレクタを選択します。 

SYSTEM オペレーションモードの選択、信号ロス時の動作、アンシラリデータ処
理等を設定します。 

STATUS ビデオ信号、基板の状態についてのデータを表示します。 

 

分類 
メニュー 

参照 
番号 項目 略称表示 

DUAL -  Select Color Corrector 1 or 2>  Sel CC> 4-2-1 

SYSTEM 1  System Setup System 4-2-2 

  1-2 
1-3 
1-4 
1-5 
1-6 
1-9 
1-10
1-11
1-12
1-13

Loss Mode> 
Back Color> 
H Ancillary Mode 
V Ancillary Mode 
Output Delay>  
Test Signal> 
Operation Mode> 
Front Brightness> 
Panel Lock> 
Input Status Display Set>  

LossMOD> 
BColor> 
H ANCI> 
V ANCI> 
Out DLY> 
TESTSIG> 
OP Mode> 
Bright> 
Lock > 
IN DSP> 

 
 

STATUS 2  System Status SYSTMSTS 4-2-3 

  2-2 
2-3 

SDI IN1 Format> 
SDI IN2 Format> 

IN1 STS> 
IN2 STS> 

 

 3  Module Information MDL INFO 4-2-4 

  3-1 
3-2 
3-3 
3-4 
3-5 
3-6 

External Control Mode> 
Version Info> 
FPGA Version Info> 
UFM-3DCC2C Option Info> 
UFM-3DCCMF Option Info> 
UFM-3DCC3G Option Info> 

CTL Mod> 
Version> 
FPGA> 
Dual Ch> 
Multi> 
3G Op> 

 

 

UFM-30DCC

カラーコレクタ 2
設定 2 

カラーコレクタ 1
設定 1 入力 1 

入力 2 

出力 1 

出力 2 
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4-1-2-4. Link モードのメニュー 

Link モードは 2 つのカラーコレクタを共通設定で使用します。 

 

 

 

 

 

 

 

 
メニュー分類 設定内容概略 

SYSTEM オペレーションモード、信号ロス時の動作、アンシラリデータ処理等を
設定します。 

STATUS ビデオ信号、基板の状態についてのデータを表示します。 

 

分類 
メニュー 

参照 
番号 項目 略称表示 

SYSTEM 1  System Setup System 4-2-2 

  1-2 
1-3 
1-4 
1-5 
1-7 
1-8 
1-9 
1-10 
1-11 
1-12 

Loss Mode> 
Back Color> 
H Ancillary Mode 
V Ancillary Mode 
Output Delay1> 
Output Delay2> 
Test Signal> 
Operation Mode> 
Front Brightness> 
Panel Lock> 

LossMOD> 
BColor> 
H ANCI> 
V ANCI> 
Out DL1> 
Out DL2> 
TESTSIG> 
OP Mode> 
Bright> 
Lock > 

 
 

STATUS 2  System Status SYSTMSTS 4-2-3 

  2-2 
2-3 

SDI IN1 Format> 
SDI IN2 Format> 

IN1 STS> 
IN2 STS> 

 

 3  Module Information MDL INFO 4-2-4 

  3-1 
3-2 
3-3 
3-4 
3-5 
3-6 

External Control Mode> 
Version Info> 
FPGA Version Info> 
UFM-3DCC2C Option Info> 
UFM-3DCCMF Option Info> 
UFM-3DCC3G Option Info> 

CTL Mod> 
Version> 
FPGA> 
Dual Ch> 
Multi> 
3G Op> 

 

 

UFM-30DCC

カラーコレクタ 2
設定 1 

カラーコレクタ 1
設定 1 入力 1

入力 2

出力 1

出力 2
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4-2. UFM-30DCC 前面パネルメニュー詳細 

4-2-1. カラーコレクタ (チャネル) 選択 

モード メニュー項目 初期値 設定範囲 内容 

Dual Select Color Corrector 1 or 2> Correct1 Correct1, 
Correct2 

設定するカラーコレクタを選
択します。 

 

4-2-2. システム設定 

メニュー 
初期値 設定範囲 内容 

番号 モード 項目 

1 System Setup 

1-1 Single Input Select > SDI In1 SDI In1, 
SDI In2 入力チャネルを選択します。 

1-2 
Single 
Dual 
Link 

Loss Mode > BackCOL
BackCOL, 
ColorBar, 
Disable 

無信号時の動作を設定します。

1-3 
Single 
Dual 
Link 

Back Color> Black 
Black, 
Gray,  
Blue 

無信号時の背景色を選択しま
す。 

1-4 
Single 
Dual 
Link 

H Ancillary Mode> Through Through, 
Delete 

Through：アンシラリデータは
一切操作されず、そのまま出力
されます。 
Delete：アンシラリデータは全
て削除されます。 1-5 

Single 
Dual 
Link 

V Ancillary Mode> Through Through, 
Delete 

1-6 Single 
Dual Output Delay> --- (*1) 

出力遅延を設定します。設定範
囲はフォーマットごとに異な
り、最小遅延から約 1H まで設
定できます。 
入力信号フォーマットが変わる
と最小値に戻ります。 

1-7 Link Output Delay1> --- (*1) 

出力 1 の出力遅延を設定しま
す。設定範囲はフォーマットご
とに異なり、最小遅延から約 1H
まで設定できます。 
入力信号フォーマットが変わる
と最小値に戻ります。 

1-8 Link Output Delay2> --- (*1) 

出力 2 の出力遅延を設定しま
す。設定範囲はフォーマットご
とに異なり、最小遅延から約 1H
まで設定できます。 
入力信号フォーマットが変わる
と最小値に戻ります。 

1-9 
Single 
Dual 
Link 

Test Signal> Off 

Off, 
Full CB, 

SMPTE CB,
RAMP 

テスト信号の発生を行います。
VIDEO メニューの設定にかか
わらず、フル画面で表示されま
す。 

1-10 
Single 
Dual 
Link 

Operation Mode> Dual 
Single, 
Dual, 
Link 

UFM-30DCC の動作モードを設
定します。(*2) 
Single: Single Channel モード 
Dual: Dual Channel モード 
Link: Link モード 

1-11 
Single 
Dual 
Link 

Front Brightness> 50% 

25%, 
50%, 
75%, 

100%, 

前面パネルの明るさを選択しま
す。 
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1-12 
Single 
Dual 
Link 

Panel Lock> Operate Operate, 
Lock 

Lock 設定にするとパネルから
のメニュー操作を全て禁止しま
す。メニューコントロールを約
2 秒以上押した状態で解除
（Operate）になります。 

1-13 Dual Input Status Display 
Set> 1min 

Off, 
1min, 
5min 

何も操作しなかった場合に、チ
ャネルごとの入力信号の有無を
自動で表示する時間を設定しま
す。(*3) 
Off：自動表示しません。 
1min：最終操作から 1 分後に自
動表示されます。 
5min：最終操作から 5 分後に自
動表示されます。 

 

(*1) Output Delay 設定範囲 
System Format Output Delay 設定範囲 

525/60 200CLK～1716CLK 

1080/59.94i 140CLK～2200CLK 

720/59.94p 140CLK～1650CLK 

625/50 200CLK～1728CLK 

1080/50i 140CLK～2640CLK 

720/50p 140CLK～1980CLK 

 

(*2) Operation Mode 項目 

Operation Mode 項目は標準構成の場合は表示されません。オプション構成の場合は、

Single Channel モード時にも表示されます。 

Single Channel モードの設定、Link モードの設定および Dual Channel モードの「設定 1」

は共通です。カラーコレクション等の設定変更後にオペレーションモードを変更すると、

変更後の設定が適用されますので注意してください。設定を戻したい場合は、イベント

に保存しておき読み込んでください。 

 

(*3) Input Status Display Set 

最後に操作してから一定時間操作せずにいると、入力の有無を，○（入力あり）×（入

力なし）で自動表示することができます。以下の例では、チャネル 1 は入力があり、チ

ャネル 2 は無入力であることを示します。 

 

表示例： IN1○IN2× 
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4-2-3. システムステータス（表示のみ） 

メニュー 
表示 

番号 モード 項目 

2 System Setup 

2-1 Single Selected SDI Input > 選択している入力信号を表示します。 

2-2 Single 
Dual 
Link 

SDI IN1 Format > SDI IN1 に入力されているビデオ信号のフォーマッ
トを表示します。 

2-3 Single 
Dual 
Link 

SDI IN2 Format > SDI IN2 に入力されているビデオ信号のフォーマッ
トを表示します。 

 

 

4-2-4. モジュール情報（表示のみ） 

メニュー 
内容 

番号 項目 

3 Module Information 

3-1 External Control Mode> 外部コントロール方法を表示します。DCC-OUA か
ら制御中は、OU Mode と表示されます。 

3-2 Version> ファームウェアのバージョンを表示します。 

3-3 FPGA> FPGA のバージョンを表示します。 

3-4 UFM-3DCC2C Option Info> Dual Channel オプションの有無を表示します。 
Install：デュアルチャネルオプション有り 
None：デュアルチャネルオプション無し 

3-5 UFM-3DCCMF Option Info> マルチフォーマットオプションの有無を表示しま
す。 
Install：マルチフォーマットオプション有り 
None：マルチフォーマットオプション無し 
※3G-SDI オプションが追加されている場合、この

項目は Install と表示されます。 

3-6 UFM-3DCC3G Option Info> 3G-SDI オプションの有無を表示します。 
Install：3G-SDI オプション有り 
None：3G-SDI オプション無し 

 

注意 

データ自動保存について 

UFM-30DCC は、最後に設定された状態を自動でデータ保存しています。 

設定変更後、3 秒以上経過後に電源を切ってください。 

設定変更後、3 秒以内に電源を切った場合設定が保存されない場合があります。
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5. WEB ブラウザ使用時 
DCC-NETOU や PC 上の WEB ブラウザから UFM-30DCC を制御するときは、UFM-30DCC が組

み込まれている UFM フレームに UFM-30CTL を組み込みます。さらに UFM-30DCC 基板上のデ

ィップスイッチ、およびジャンパ設定で DCC-OUA 制御を WEB 制御に変更する必要があります。

（「6. 内部設定」）WEB ブラウザ使用時も、UFM-30DCC 前面パネルから制御できますが、

DCC-OUA 等のオペレーションユニットからは制御できなくなります。 
 

WEB からの制御については「UFM-30CTL 取扱説明書」を参照してください。 

DCC-NETOUから UFM-30DCCを操作する場合に UFM-30DCCの前面パネルから操作可能な項

目は、WEB ブラウザ操作時と同じになります。DCC-NETOU からの操作については

「DCC-NETOU 取扱説明書」を参照してください。 

 

 

5-1. UFM-30DCC 前面パネルメニューリスト 

5-1-1. カラーコレクタ 1 チャネル構成 

入力 1 選択時 

 

 

 

 

 

 

 

入力 2 選択時 

 

 

 

 

 

 

5-1-1-1. 標準構成 1 チャネルのメニュー 

メニュー分類 設定内容概略 

Video Process AMP プロセスアンプを設定します。 

Color Correction カラーコレクションを設定します。 

Video Clip ビデオクリップを設定します。 

SYSTEM 入力選択、信号ロス、アンシラリデータ処理等を設定します。 

UTILITY イベントメモリ、LED 画面設定を操作します。 

STATUS ビデオ信号、基板の状態についてのデータを表示します。 

 

注意 
Bypass/Operate 項目 (下表 4-02) が Bypass に設定されているときは、VIDEO

メニューの項目はすべて設定できません。Operate に変更してから設定を行

ってください。 

 

UFM-30DCC

入力 1 

入力 2 

カラーコレクタ 1
設定 1 

出力 1 

出力 2 

UFM-30DCC

入力 1 

入力 2 

カラーコレクタ 1
設定 1 

出力 1 

出力 2 
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 Video Process AMP メニュー 
メニュー 

参照 
番号 Correction Mode 設定 (*1) 項目 略称表示 

1   Video Process AMP Process 5-2-2 

 1-01 DIF, BAL, SEPIA Video Level >  VID LVL>  

 1-02 DIF, BAL, SEPIA Y Level >  Y Level>  

 1-03 DIF, BAL Chroma Level >  C Level>  

 1-04 DIF, BAL, SEPIA Setup/Black Level >  Blk LVL>  

 1-05 DIF, BAL Hue >  Hue >  

(*1)「2-02 Correction Mode」が SEPIA に設定されている場合は Chroma Level と Hue は設定できません。

 

 Color Correction メニュー 
メニュー 

参照 
番号 Correction Mode 設定 (*1) 項目 略称表示 

2   Color Correction Correct 5-2-3 

 2-01 DIF, BAL, SEPIA Split Mode >  Split>  

 2-02 -- Correction Mode >  CRT MOD>  

 2-03 DIF, BAL Group Adjustment >  GRP ADJ>  

 2-04 DIF, BAL White Level Red >  White R>  

 2-05 DIF, BAL White Level Green >  White G>  

 2-06 DIF, BAL White Level Blue >  White B>  

 2-07 DIF, BAL Black Level Red >  Black R>  

 2-08 DIF, BAL Black Level Green >  Black G>  

 2-09 DIF, BAL Black Level Blue >  Black B>  

 2-10 DIF, BAL, SEPIA Gamma Curve >  Gamma >  

 2-11 DIF, BAL Gamma Level Red >  Gamma R>  

 2-12 DIF, BAL, SEPIA Gamma Level Green >  Gamma G>  

 2-13 DIF, BAL Gamma Level Blue >  Gamma B>  

 2-14 SEPIA Sepia Level > Sepia L>  

 2-15 SEPIA Sepia Color >  Sepia C>  

(*1) 「2-02 Correction Mode」のモード設定により調整できる項目が変わります。 

 

 Video Clip メニュー 
メニュー 

参照 
番号 Video Clip Mode 設定 (*1) 項目 略称表示 

3   Video Clip VID Clip 5-2-4 

 3-01 --- Video Clip Mode>  CLP MOD>  

 3-02 YPbPr Y White Clip> Y White>  

 3-03 YPbPr Y Black Clip>  Y Black>  

 3-04 YPbPr Chroma Clip>  C Clip>  

 3-05 GBR GBR White Clip> GBR WHT>  

 3-06 GBR GBR Black Clip>  GBR BLK>  

 3-07 VBS Composite White Clip> VBS WHT>  

 3-08 VBS Composite Black Clip>  VBS BLK>  

(*1) 「3-01 Video Clip Mode」のモード設定により調整できる項目が変わります。 
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 SYSTEM メニュー 
メニュー 

参照 
番号 項目 略称表示 

4  System Setting System 5-2-5 

 4-01 Input Select>  IN SEL>  

 4-02 Bypass/Operate> By-Op>  

 4-03 Loss Mode> LossMOD>  

 4-04 Back Color> BColor>  

 4-05 H Ancillary Mode> H ANCI>  

 4-06 V Ancillary Mode> V ANCI>  

 4-07 Output Delay>  Out DLY>  

 4-10 Test Signal Test SIG  

 

 UTILITY メニュー 
メニュー 

参照 
番号 項目 略称表示 

5  Event Memory EventMEM 5-2-6 

 5-01 Start Up Event Load> (*1)(*2) STUP EL>  

 5-02 Auto Event Load> (*1) Auto EL>  

 5-03 Event Load> (*1)(*2) Ev Load>  

 5-04 Event Save> (*1)(*2) Ev Save>  

6  Front Panel Setting PanelSET 5-2-7 

 6-01 Front Brightness> Bright>  

 6-02 Panel Lock> Lock>  

(*1) 「4-02 Bypass/Operate」が Bypass に設定された場合、設定変更できなくなります。設定しよう
とすると、「In Bypass, it doesn't operate」の警告メッセージが表示されます。 

(*2) Auto Event Load 項目を Enable に設定すると、Event Load / Event Save 操作はできません。また、
Auto Event Load 項目設定が Enable のまま電源を切り、再度電源を投入した場合、Start Up Event 
Load 設定よりも Auto Event Load 設定が優先されて起動します。また、Auto Event Load 項目設
定が Enable のときは、Start Up Event Load 項目の設定変更はできません。設定しようとすると、
「Auto Event Load Enable!」の警告メッセージが表示されます。 

 

 STATUS メニュー 
メニュー 

参照 
番号 項目 略称表示 

7  System Status SYSTMSTS 5-2-8 

 7-01 Selected SDI Input> SEL IN>  

 7-02 SDI IN1 Format> IN1 STS>  

 7-03 SDI IN2 Format> IN2 STS>  

8  Module Information MDL INFO 5-2-9 

 8-01 Slot Number> Slot NO>  

 8-02 External Control Mode> CTL Mod>  

 8-03 Version Info> Version>  

 8-04 FPGA Version Info> FPGA>  

 8-05 UFM-3DCC2C Option Info> Dual Ch>  

 8-06 UFM-3DCCMF Option Info> Multi>  

 8-07 UFM-3DCC3G Option Info> 3G Op>  
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5-1-2. カラーコレクタ 2 チャネル構成 (UFM-3DCC2C オプション)  

5-1-2-1. モード選択 

2 チャネル構成時は、Single Channel モード、2 系統の入力を個別の設定で処理する Dual 

Channel モード、2 系統の入力を同じ設定で処理する Link モードの 3 つを使用できま

す。SYSTEM メニューの「4-11 Operation Mode」でモードを選択してください。 

 

注意 

Single Channel モードの設定、Link モードの設定、および Dual Channel モ

ードの「設定 1」は共通です。カラーコレクション等の設定変更後にオペ

レーションモードを変更すると、変更後の設定が適用されますので注意し

てください。設定を戻したい場合は、イベントに保存しておき読み込んで

ください。 

 

 

5-1-2-2. Single Channel モードメニュー 

2 チャネル構成時の Single Channel モードのメニューは、標準構成 1 チャネルのメニュ

ーとほとんど同じです。「4-11 Operation Mode」を設定できるところだけが異なります。

「5-1-1. カラーコレクタ 1 チャネル構成」を参照してください。 

 

5-1-2-3. Dual Channel モードメニュー 

Dual Channel モードでは 2 つのカラーコレクタを個別設定で使用できます。まず、Select 

Color Corrector 1 or 2 項目でチャネルを選択してから設定を行ってください。 

 

 

 

 

 

 

 

 
メニュー分類 設定内容概略 

DUAL 設定を行うカラーコレクタを選択します。 

Video Process AMP プロセスアンプを設定します。 

Color Correction カラーコレクションを設定します。 

Video Clip ビデオクリップを設定します。 

SYSTEM 入力選択、信号ロス、アンシラリデータ処理等を設定します。 

UTILITY イベントメモリ、LED 画面設定を操作します。 

STATUS ビデオ信号、基板の状態についてのデータを表示します。 

 

分類 
メニュー 

参照 
番号 項目 略称表示 

DUAL － Select Color Corrector1 or 2> Sel CC> 5-2-2 

 

VIDEO 設定はすべてのモードで共通です。「5-1-1. カラコレ 1 チャネル構成」を参

照してください。 

UFM-30DCC

カラーコレクタ 2
設定 2 

カラーコレクタ 1
設定 1 入力 1 

入力 2 

出力 1 

出力 2 
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 SYSTEM メニュー 
メニュー 

参照 
番号 項目 略称表示 

4  System Setting System 5-2-5 

 4-02 Bypass/Operate> By-Op>  

 4-03 Loss Mode> LossMOD>  

 4-04 Back Color> BColor>  

 4-05 H Ancillary Mode> H ANCI>  

 4-06 V Ancillary Mode> V ANCI>  

 4-07 Output Delay>  Out DLY>  

 4-10 Test Signal Test SIG  

 4-11 Operation Mode> OP Mode>  

 

 UTILITY メニュー 
メニュー 

参照 
番号 項目 略称表示 

5  Event Memory EventMEM 5-2-6 

 5-01 Start Up Event Load> (*1)(*2) STUP EL>  

 5-02 Auto Event Load> (*1) Auto EL>  

 5-03 Event Load> (*1)(*2) Ev Load>  

 5-04 Event Save> (*1)(*2) Ev Save>  

6  Front Panel Setting PanelSET 5-2-7 

 6-01 Front Brightness> Bright>  

 6-02 Panel Lock> Lock>  

 6-03 Input Status Display Set> IN DSP>  

(*1) 「4-02 Bypass/Operate」が Bypass に設定された場合、設定変更できなくなります。設定しよう
とすると、「In Bypass, it doesn't operate」の警告メッセージが表示されます。 

(*2) Auto Event Load 項目を Enable に設定すると、Event Load / Event Save 操作はできません。また、
Auto Event Load 項目設定が Enable のまま電源を切り、再度電源を投入した場合、Start Up Event 
Load 設定よりも Auto Event Load 設定が優先されて起動します。また、Auto Event Load 項目設
定が Enable のときは、Start Up Event Load 項目の設定変更はできません。設定しようとすると、
「Auto Event Load Enable!」の警告メッセージが表示されます。 

 

 STATUS メニュー 
メニュー 

参照 
番号 項目 略称表示 

7  System Status SYSTMSTS 5-2-8 

 7-02 SDI IN1 Format> IN1 STS>  

 7-03 SDI IN2 Format> IN2 STS>  

8  Module Information MDL INFO 5-2-9 

 8-01 Slot Number> Slot NO>  

 8-02 External Control Mode> CTL Mod>  

 8-03 Version Info> Version>  

 8-04 FPGA Version Info> FPGA>  

 8-05 UFM-3DCC2C Option Info> Dual Ch>  

 8-06 UFM-3DCCMF Option Info> Multi>  

 8-07 UFM-3DCC3G Option Info> 3G Op>  



 

23 

5-1-2-4. Link モードメニュー 

Link モードメニューは 2 つのカラーコレクタを同じ設定で使用できます。Link モード

の設定を変更すると、Single モード設定および Dual Channel モードの「設定 1」も変更

されますので注意してください。 

 

 

 

 

 

 

 

 
メニュー分類 設定内容概略 

Video Process AMP プロセスアンプを設定します。 

Color Correction カラーコレクションを設定します。 

Video Clip ビデオクリップを設定します。 

SYSTEM 入力選択、信号ロス、アンシラリデータ処理等を設定します。 

UTILITY イベントメモリ、LED 画面設定を操作します。 

STATUS ビデオ信号、基板の状態についてのデータを表示します。 

 

Video Process AMP、Color Correction、Video Clip 設定はすべてのモードで共通です。

「5-1-1. カラーコレクタ 1 チャネル構成」を参照してください。 

 

 SYSTEM メニュー 
メニュー 

参照 
番号 項目 略称表示 

4  System Setting System 5-2-5 

 4-02 Bypass/Operate> By-Op>  

 4-03 Loss Mode> LossMOD>  

 4-04 Back Color> BColor>  

 4-05 H Ancillary Mode> H ANCI>  

 4-06 V Ancillary Mode> V ANCI>  

 4-08 Output Delay 1>  Out DL1>  

 4-09 Output Delay 2>  Out DL2>  

 4-10 Test Signal Test SIG  

 4-11 Operation Mode> OP Mode>  

 

UFM-30DCC

カラーコレクタ 2
設定 1 

カラーコレクタ 1
設定 1 入力 1 

入力 2 

出力 1 

出力 2 
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 UTILITY メニュー 
メニュー 

参照 
番号 項目 略称表示 

5  Event Memory EventMEM 5-2-6 

 5-01 Start Up Event Load> (*1)(*2) STUP EL>  

 5-02 Auto Event Load> (*1)(*2) Auto EL>  

 5-03 Event Load> (*1)(*2) Ev Load>  

 5-04 Event Save> (*1)(*2) Ev Save>  

6  Front Panel Setting PanelSET 5-2-7 

 6-01 Front Brightness> Bright>  

 6-02 Panel Lock> Lock>  

(*1) 「4-02 Bypass/Operate」が Bypass に設定された場合、設定変更できなくなります。設定しよう
とすると、「In Bypass, it doesn't operate」の警告メッセージが表示されます。 

(*2) 「4-11 Operation Mode」が Link の場合、VID FRMT は設定項目に表示されません。また、Auto 
Event Load 項目は選択できません。Auto Event Load 項目を設定しようとすると、「In Link Mode, 
it doesn't operate」の警告メッセージが表示されます。 

 

 STATUS メニュー 
メニュー 

参照 
番号 項目 略称表示 

7  System Status SYSTMSTS 5-2-8 

 7-02 SDI IN1 Format> IN1 STS>  

 7-03 SDI IN2 Format> IN2 STS>  

8  Module Information MDL INFO 5-2-9 

 8-01 Slot Number> Slot NO>  

 8-02 External Control Mode> CTL Mod>  

 8-03 Version Info> Version>  

 8-04 FPGA Version Info> FPGA>  

 8-05 UFM-3DCC2C Option Info> Dual Ch>  

 8-06 UFM-3DCCMF Option Info> Multi>  

 8-07 UFM-3DCC3G Option Info> 3G Op>  
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5-2. UFM-30DCC 前面パネルメニュー詳細 

5-2-1. カラーコレクタ (チャネル) 選択 

カラーコレクタ選択は Dual Channel モード時に表示されます。 

 

メニュー項目 初期値 設定範囲 内容 

Select Color Corrector 1 or 2> Correct1 Correct1, 
Correct2 

設定変更を行うチャネルの選択
を行います。 

 

 

5-2-2. プロセスアンプ 

3 つのモード共通のメニューです。「2-02 Correction Mode」の設定により表示される項目が

変わります。 

 

番号 Correction 
Mode 設定 メニュー項目 初期値 設定範囲 

(設定単位) 内容 

1 Video Process AMP 

1-01 DIF, BAL, 
SEPIA Video Level> 100.0% 0.0～200.0% 

(0.1%) 
ビデオレベルを設
定します。 

1-02 DIF, BAL, 
SEPIA Y Level> 100.0% 0.0～200.0% 

(0.1%) 
ルミナンスレベル
を設定します。 

1-03 DIF, BAL Chroma Level> 100.0% 0.0～200.0% 
(0.1%) 

クロマレベルを設
定します。(*1)  

1-04 DIF, BAL, 
SEPIA Setup/Black Level> 0.0% -7.0～25.0% 

(0.1%) 
ブラックレベルを
設定します。 

1-05 DIF, BAL Hue> 0.0° -180.0～180.0° 
(0.1°) 

色位相を設定しま
す。(*1)  

(*1) 「2-02 Correction Mode」が SEPIA の場合、Chroma Level 項目、および Hue 項目の選択はできませ
ん。項目を設定しようとすると、「In Sepia Mode, it doesn't operate」の警告メッセージが表示されま
す。 

 

 

5-2-3. カラーコレクション 

3 つのモード共通のメニューです。「2-02 Correction Mode」の設定により表示される項目が

変わります。 

 

番号 Correction 
Mode 設定 メニュー項目 初期値 設定範囲 

(設定単位) 内容 

2 Color Correction 

2-01 DIF, BAL, 
SEPIA Split Mode> Mode Off Mode Off, 

Mode1～3 

出力ビデオのスプリットモ
ード(分割比較画面表示)を
設定します。 
Off：補正後の映像出力 
Mode1：入力映像と補正映像
が縦半分ずつ表示 
Mode2：入力映像と補正映像
が横半分ずつ表示 
Mode3：入力映像をそのまま
出力 
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2-02 -- Correction 
Mode> BALANCE

BALANCE, 
DIF, 

SEPIA 

コレクションモードを
BALANCE (RGB)、 
DIFFERENTIAL (色差)、
SEPIA から選択します。 
BALANCE: RGB 信号補正

モード 
映像のホワイトバランス
を補正する際に使用しま
す。R・G・B の各レベル
を操作することにより、
映像のグレースケールを
変化させることができま
す。 

DIFFERENTIAL: 色差信号
補正モードホワイトバラ
ンスを一定に保ったまま
「色の濃淡の違い」を補
正する際に使用します。
R・G・B の各レベルを操
作しても映像のグレース
ケールには影響を与えま
せん。映像の各色別の飽
和度が異なっているとき
に使用すると有効です。

SEPIA: セピアモード 
モノトーンでの画像作り
の際に使用します。 

2-03 DIF, BAL Group 
Adjustment> Off Off, 

On 

RGB を同時、または個別に
設定できます。(*1) 
Off：RGB 個別設定 
On：RGB 同時設定 

2-04 DIF, BAL White Level 
Red> 

0.0% 0.0～200.0% 
(0.1%) 

RGB でホワイトレベルを設
定します。(*2) 2-05 DIF, BAL White Level 

Green> 

2-06 DIF, BAL White Level 
Blue> 

2-07 DIF, BAL Black Level 
Red> 

0.0% 0.0～200.0% 
(0.1%) 

RGB でブラックレベルを設
定します。(*2) 2-08 DIF, BAL Black Level 

Green> 

2-09 DIF, BAL Black Level 
Blue> 

2-10 DIF, BAL, 
SEPIA 

Gamma 
Curve> Center 

Center, 
Black, 
White 

ガンマカーブ補正の中心を
選択します。 
Center：ガンマカーブの 50%
近傍を中心に補正処理 
Black：ガンマカーブの 25%
近傍を中心に補正処理 
White：ガンマカーブの 75%
近傍を中心に補正処理 

2-11 DIF, BAL Gamma Level 
Red> 

0.0% 0.0～200.0% 
(0.1%) 

RGB でガンマレベルを設定
します。(*3) 2-12 DIF, BAL, 

SEPIA 
Gamma Level 
Green> 

2-13 DIF, BAL Gamma Level 
Blue> 

2-14 SEPIA Sepia Level> 25.0% 0.0～100.0% 
(0.1%) 

セピアモード時にセピアレ
ベルを設定します。(*4) 

2-15 SEPIA Sepia Color> -160.0° -180.0～180.0°
(0.1°) 

セピアモード時にセピアカ
ラーを設定します。(*4) 
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(*1)「Group Adjustment」は WEB 制御とは連動していません。 
(*2)「2-02 Correction Mode」が SEPIA の場合、White Level Red / Green / Blue の各項目、および Black Level 

Red / Green / Blue の各項目は選択できません。その項目を設定しようとすると、「In Sepia Mode, it 
doesn't operate」の警告メッセージが表示されます。 

(*3)「2-02 Correction Mode」が SEPIA の場合、Gamma Level Green 項目で Y 信号のみ設定可能となりま
す。また、Gamma Level Red / Blue 項目は選択できません。その項目を設定しようとすると、「In Sepia 
Mode,it doesn't operate」の警告メッセージが表示されます。 

(*4)「2-02 Correction Mode」が BALANCE、または DIF の場合、Sepia Level / Color 項目は選択できませ
ん。その項目を設定しようとすると、「In BAL Mode, it doesn't operate」、または「In DIF Mode, it doesn't 
operate」の警告メッセージが表示されます。 

 

 

5-2-4. クリップコントロール 

3 つのモード共通のメニューです。「3-01 Video Clip Mode」のモード設定により調整できる

項目が変わります。 

 

番号 Video Clip 
Mode 設定 メニュー項目 初期値 設定範囲 

(設定単位) 内容 

3 Video Clip 

3-01 --- Video Clip 
Mode> Off 

Off, 
YPbPr, 
GBR, 
VBS 

クリップモードを選択しま
す。 
Off：クリップモードは動作しま
せん。 
YPbPr：YPbPr カラー空間で
クリップ動作します。 
GBR：GBR カラー空間でクリ
ップ動作します。 
VBS：コンポジットカラー空
間で動作します。 

3-02 YPbPr Y White Clip> 109.0% 50.0～109.0%
(0.1%) 

Y 信号のホワイトクリップを
設定します。(*1) 

3-03 YPbPr Y Black Clip> -7.0% -7.0～50.0% 
(0.1%) 

Y 信号のブラッククリップを
設定します。(*1) 

3-04 YPbPr Chroma Clip> 113.0% 50.0～113.0%
(0.1%) 

C 信号のホワイトクリップを
設定します。(*1) 

3-05 GBR GBR White Clip> 300.0% 50.0～300.0%
(0.1%) 

GBR 信号のホワイトクリッ
プを設定します。(*2) 

3-06 GBR GBR Black Clip> -200.0% -200.0～50.0%
(0.1%) 

GBR 信号のブラッククリッ
プを設定します。(*2) 

3-07 VBS Composite White 
Clip> 150.0% 50.0～150.0%

(0.1%) 

Composite（VBS）信号のホワ
イトクリップを設定します。
(*3) 

3-08 VBS Composite Black 
Clip> -50.0%

-50.0～50.0%
(0.1%) 

Composite（VBS）信号のブラ
ッククリップを設定します。
(*3) 

(*1)「YPbPr クリップ調整 (p28)」参照 
「3-01 Video Clip Mode」が Off、GBR または VBS の場合、その項目は選択できません。項目を設定
しようとすると、「In Clip Off, it doesn't operate」、「In GBR Clip, it doesn't operate」、「In VBS Clip, it 
doesn't operate」の警告メッセージが表示されます。 

(*2)「GBR クリップ調整 (p29)」参照 
「3-01 Video Clip Mode」が Off、YPbPr または VBS の場合、その項目は選択できません。項目を設
定しようとすると、「In Clip Off, it doesn't operate」、「In YPbPr Clip,it doesn't operate」、「In VBS Clip, 
it doesn't operate」の警告メッセージが表示されます。 

(*3)「Composite クリップ調整 (p29)」参照 
「3-01 Video Clip Mode」が Off、YPbPr または GBR の場合、その項目は選択できません。項目を設
定しようとすると、「In Clip Off, it doesn't operate」、「In YPbPr Clip,it doesn't operate」、「In GBR Clip, 
it doesn't operate」のいずれかの警告メッセージが表示されます。 
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 YPbPr クリップ調整 

Y ホワイトクリップレベル 

 

 

 

 

 

 

 

 

 

 

 

 

 

Y ブラッククリップレベル 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

C ホワイトクリップレベル 

 

 

 

 

 

 

 

 

 

 

 

 

 

SMPTE 100% カラーバー 100% ホワイト基準

109%
100%

50%

 50% 

0%

Y ホワイトクリップ 
の可変範囲 

SMPTE 100% カラーバー 100% ブラック基準

100%

50%

0%

50% 

-7%

Y ブラッククリップ
の可変範囲 

50% 

50% 

0% 

50%

100%

113%

SMPTE 100% カラーバー 700mVp-p（100%） カラー基準

C ホワイトクリップ
の可変範囲 
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 GBR クリップ調整 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Composite クリップ調整 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

300% 
White Clip 初期値 

100% 

-200%
Black Clip 初期値 

0% 

50% 

GBR クリップ補正概略図

ブラッククリップ 
の可変範囲 

ホワイトクリップ 
の可変範囲 

150% 

100% 

0% 

-50% 

50% 

コンポジット補正概略図

White Clip 初期値 

Black Clip 初期値 

ブラッククリップ 
の可変範囲 

ホワイトクリップ 
の可変範囲 
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5-2-5. システム設定 

システム設定に表示される項目は 3 つのモードで異なります。 

 
メニュー 

初期値 設定範囲 内容 
番号 モード 項目 

4 System Setup 

4-01 Single Input Select> SDI In1 SDI In1, 
SDI In2 入力チャネルを選択します。 

4-02 
Single 
Dual 
Link 

Bypass/Operate> Operate Operate, 
Bypass 

バイパス設定にすると、制御中の
UFM-30DCC から出力される信
号は、入力信号が処理されずに出
力されます。(*1) 

4-03 
Single 
Dual 
Link 

Loss Mode> Back 
COL 

BackCOL, 
ColorBar, 
Disable 

無信号時の動作を設定します。 

4-04 
Single 
Dual 
Link 

Back Color> Black 
Black, 
Gray, 
Blue 

無信号時の背景色を選択します。

4-05 
Single 
Dual 
Link 

H Ancillary Mode> Through Through, 
Delete 

Through：アンシラリデータは一
切操作されず、そのまま出力され
ます。 
Delete：アンシラリデータは全て
削除されます。 4-06 

Single 
Dual 
Link 

V Ancillary Mode> Through Through, 
Delete 

4-07 Single 
Dual Output Delay> --- (*2) 

出力遅延を設定します。設定範囲
はフォーマットごとに異なり、最
小遅延から約 1H まで設定できま
す。 
入力信号フォーマットが変わる
と最小値に戻ります。 

4-08 Link Output Delay1> --- (*2) 

出力 1 の出力遅延を設定します。
設定範囲はフォーマットごとに
異なり、最小遅延から約 1H まで
設定できます。 
入力信号フォーマットが変わる
と最小値に戻ります。 

4-09 Link Output Delay2> --- (*2) 

出力 2 の出力遅延を設定します。
設定範囲はフォーマットごとに
異なり、最小遅延から約 1H まで
設定できます。 
入力信号フォーマットが変わる
と最小値に戻ります。 

4-10 
Single 
Dual 
Link 

Test Signal> Off 

Off, 
Full CB, 

SMPTE CB,
RAMP 

テスト信号の発生を行います。
VIDEO メニューの設定にかかわ
らず、フル画面で表示されます。

4-11 
Single 
Dual 
Link 

Operation Mode > Dual 
Single, 
Dual, 
Link 

UFM-30DCC の動作モードを設
定します。(*3) 
Single: Single Channel モード 
Dual: Dual Channel モード 
Link: Link モード 

 

(*1) Bypass 設定時 

Bypass を選択すると次ページの表の項目以外は選択できません。それ以外の項目を設

定／表示しようとすると、「In Bypass, it doesn't operate」の警告メッセージが表示され

ます。 
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項目 参照 

Select Color Corrector 1 or 2 5-2-1. カラーコレクタ選択 

System Setting 5-2-5. システム設定 

Front Panel Setting 5-2-7. 前面パネル設定 

System Status 5-2-8. システムステータス 

Module Information 5-2-9. モジュール情報 
 

(*2) Output Delay の設定範囲 
System Format Output Delay 設定範囲 

525/60 200CLK～1716CLK 

1080/59.94i 140CLK～2200CLK 

720/59.94p 140CLK～1650CLK 

625/50 200CLK～1728CLK 

1080/50i 140CLK～2640CLK 

720/50p 140CLK～1980CLK 
 

(*3) Operation Mode 項目 

Operation Mode 項目は標準構成の場合は表示されません。オプション構成の場合は、

Single Channel モード時にも表示されます。 

Single Channel モードの設定、Link モードの設定、および Dual Channel モードの「設定

1」は共通です。カラーコレクション等の設定変更後にオペレーションモードを変更す

ると、変更後の設定が適用されますので注意してください。設定を戻したい場合は、イ

ベントに保存しておき読み込んでください。 
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5-2-6. イベントメモリ 

メニュー 
初期値 設定範囲 内容 

番号 項目 

6 Event Memory 

6-01 
Start Up Event 
Load >  
(*1)(*2)(*3) 

Last Set 

Last Set, 
VID FRMT,

Default, 
Event 1～50

電源起動時に読出しを行うイベントを
指定します。 
Last Set：電源投入前の状態で起動しま
す。(*3) 
VID FRMT：電源投入前の最後に検出
されたビデオ信号でビデオ信号別の設
定状態で起動します。 
Default：初期値状態で起動します。 
Event 1～50：Event 1～50 に保存された
内容で起動します。 

6-02 Auto Event Load > 
(*1)(*3) Disable Disable, 

Enable 

Enable：入力ビデオ信号に追従して、
ビデオ信号別の設定状態を自動ロード
します。 

6-03 Event Load >  
(*1)(*3)(*4) - 

Default,  
VID FRMT,
Event 1～50

Default：初期値状態にします。 
VID FRMT：動作中のビデオ信号別に
保存されているイベントをロードしま
す。 
Event 1～50：50 個の個別設定内容のイ
ベント。イベントをロードするにはイ
ベント番号を選択し、Unity ボタンを押
します。(*6) 

6-04 Event Save > 
(*1)(*3)(*5) - VID FRMT,

 Event 1～50

VID FRMT：動作中のビデオ信号別に
設定に保存します。 
Event 1～50：50 個の個別設定内容のイ
ベント。イベントをセーブするにはイ
ベント番号を選択し、Unity ボタンを押
します。(*6) 

(*1) Auto Event Load 項目を Enable に設定すると、Event Load / Event Save 操作はできません。

また、Auto Event Load 項目設定が Enable のまま電源を切り、再度電源を投入した場合、

Start Up Event Load設定よりもAuto Event Load設定が優先されて起動します。また、Auto 

Event Load 項目設定が Enable のときは、Start Up Event Load 項目の設定変更はできませ

ん。設定しようとすると、「Auto Event Load Enable!」の警告メッセージが表示されます。 

 

(*2) 起動時に読み込んだデータ（Start Up Event Load 項目で選択）と電源投入前の最後に検

出されたビデオ信号フォーマットが異なる場合、「4-07 Output Delay」、「4-08 Output 

Delay1」、および「4-09 Output Delay2」の設定値は電源投入時のビデオ信号フォーマッ

トの初期値が設定されます。 

 

(*3)「4-11 Operation Mode」が Link の場合、VID FRMT は設定項目に表示されません。ま

た、Auto Event Load 項目は選択できません。Auto Event Load 項目を設定しようとした

場合、「In Link Mode, it doesn't operate」の警告メッセージが表示されます。 

 

「4-11 Operation Mode」をLinkに変更したとき、下記の項目がVID FRMTまたはEnable

に設定されていた場合、設定値は自動的に変更されます。 
項目 変更前の設定値 変更後の設定値 

5-01 Start Up Event Load VID FRMT Last Set 

5-02 Auto Event Load Enable Disable 

5-03 Event Load VID FRMT Default 

5-04 Event Save VID FRMT Event1 
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(*4) イベントロードの際、「4-07 Output Delay」、「4-08 Output Delay1」、および「4-09 Output 

Delay2」は以下のような動作をします。 
 

 イベントセーブ時と入力フォーマットが同じ場合 

保存したデータがそのままロードされます。（下表の例参照） 
 入力フォーマット Output Delay 設定値 

イベントセーブ時 1080/59.94i 230CLK 

イベントロード時 1080/59.94i 230CLK 
 

 イベントセーブ時と入力フォーマットは異なるが、イベントセーブ時の設定値が

イベントロード時の入力フォーマットの設定範囲内の場合 

保存したデータがそのままロードされます。（下表の例参照） 
 入力フォーマット Output Delay 設定値 

イベントセーブ時 1080/59.94i 230CLK 

イベントロード時 525/60 230CLK 
 

 イベントセーブ時と入力フォーマットが異なり、イベントセーブ時の設定値もイ

ベントロード時の入力フォーマットの設定範囲を超えている場合 

イベントロード時の入力フォーマットの最大値、または最小値が設定されます。（下

の 2 つの表例参照） 
 

.例 1) 保存されている Output Delayの設定値がロード時の設定範囲以下だった場合 
 入力フォーマット Output Delay 設定値 

イベントセーブ時 1080/59.94i 150CLK 

イベントロード時 525/60 200CLK(設定範囲の最小値) 

 

例 2) 保存されている Output Delay の設定値がロード時の設定範囲以上だった場合 
 入力フォーマット Output Delay 設定値 

イベントセーブ時 1080/59.94i 2000CLK 

イベントロード時 525/60 1716CLK(設定範囲の最大値) 
 

(*5) 次の設定データはイベントに保存されません。 
項目 参照 

Select Color Corrector 1 or 2 5-2-1. カラーコレクタ選択 

Group Adjustment 5-2-3. カラーコレクション 

Operation Mode 5-2-5. システム設定 

Front Panel Setting 5-2-7. 前面パネル設定 

System Status 5-2-8. システムステータス 

Module Information 5-2-9. モジュール情報 
 

(*6) Event1～50 はすべての動作モードで共通です。 
 

Event1～50、VID FRMT の出荷時設定には、初期値が登録されています 

 

注意 

データ自動保存について 

UFM-30DCC は、最後に設定された状態を自動でデータ保存しています。 

設定変更後、3 秒以上経過後に電源を切ってください。 

設定変更後、3 秒以内に電源を切った場合設定が保存されない場合があります。
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5-2-6-1. VID FRMT (VIDEO FORMAT) イベントメモリについて 

UFM-30DCC は、入力ビデオ信号フォーマット毎にイベントメモリが用意されており、

入力ビデオ信号のフォーマットが変わると、自動でフォーマットに合わせた設定を呼び

出すことができます。 

 

 操作方法 

 

ビデオ信号フォーマット毎の保存方法（525/60 の場合） 

1. UFM-30DCC 背面の SDI1 へ 525/60 フォーマットの信号を入力します。 

2. Input Select 項目が 1 になっていることを確認します。 

3. 必要な設定を行います。 

4. Auto Event Load 項目が Disable になっていることを確認します。 

5. Event Save 項目で VID FRMT を選択し、UNITY ボタンを押し、設定をイベントメ

モリに保存します。525/60 用のイベントメモリに設定状態が保存されます。 

 

※ 625/50、1080/59.94i、1080/50i、720/59.94p、720/50p 等のフォーマット設定を登録

したい場合は、対応するフォーマットの信号を SDI1 へ入力し 1 から 5 の操作を行

います。 

※ 手順 2 で Input Select 項目を 2 に設定することも可能です。この場合は、SDI2 入力

に信号を入力してください。 

※ Dual Channel モードの場合、チャネル 1、チャネル 2 でそれぞれ VID FRMT に設定

状態を保存できます。また、チャネル 1 の VID FRMT は Single Channel モードと共通

です。 

 

ビデオ信号フォーマット毎のイベントを手動で読み込む方法 

1. イベント登録済みフォーマットのビデオ信号を UFM-30DCC に入力します。 

2. Auto Event Load 項目が Disable になっていることを確認します。 

3. Event Load 項目で VID FRMT を選択し、UNITY ボタンを押します。入力信号のフ

ォーマットに合ったイベントが読み込まれます。 

 

注意 

「4-11 Operation Mode」項目が Link の場合、VID FRMT は設定項目に表示

されません。また、Auto Event Load 項目は選択できません。Auto Event Load

項目を設定しようとすると、「In Link Mode, it doesn't operate」の警告メッ

セージが表示されます。 
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5-2-7. 前面パネル設定 

メニュー 
初期値 設定範囲 内容 

番号 モード 項目 

6 Front Panel Setting 

6-01 
Single 
Dual 
Link 

Front Brightness> 50% 

25%, 
50%, 
75%, 
100% 

前面パネルの明るさを選択しま
す。 

6-02 
Single 
Dual 
Link 

Panel Lock> Operate Operate,
Lock 

Lock 設定にするとパネルからの
メニュー操作を全て禁止します。
メニューコントロールを約 2 秒
以上押すとロックが解除され、
Operate モードになります。 

6-03 Dual Input Status Display 
Set> 1min 

Off, 
1min, 
5min 

何も操作しなかった場合に、チャ
ネルごとの入力信号の有無を自
動で表示する時間を設定します。
Off：自動表示しません。 
1min：最終操作から 1 分後に自
動表示されます。 
5min：最終操作から 5 分後に自
動表示されます。 

 

5-2-8. システムステータス（表示のみ） 

メニュー 
内容 

番号 モード 項目 

8 System Status 

8-01 Single Selected SDI Input> 選択している入力信号を表示します。(*1)  

8-02 
Single 
Dual 
Link 

SDI IN1 Format> SDI IN1 に入力されているビデオ信号のフォーマットを
表示します。 

8-03 
Single 
Dual 
Link 

SDI IN2 Format> SDI IN2 に入力されているビデオ信号のフォーマットを
表示します。 

 

5-2-9. モジュール情報（表示のみ） 

メニュー 
内容 

番号 項目 

9 Module Information 

9-01 Slot Number> 基板が実装されているスロット番号を表示します。 

9-02 External Control Mode> 
外部コントロール方法を表示します。 
WEB ブラウザから制御しているときは、MD CTL と表
示されます。 

9-03 Version Info> ファームウェアのバージョンを表示します。 

9-04 FPGA Version Info> FPGA のバージョンを表示します。 

9-05 
UFM-3DCC2C Option Info> デュアルチャネルオプションの有無を表示します。 

Install：デュアルチャネルオプション有り 
None：デュアルチャネルオプション無し 

9-06 

UFM-3DCCMF Option Info> マルチフォーマットオプションの有無を表示します。
Install：マルチフォーマットオプション有り 
None：マルチフォーマットオプション無し 
※3G-SDI オプションが追加されている場合、この項目

は Install と表示されます。 

9-07 
UFM-3DCC3G Option Info> 3G-SDI オプションの有無を表示します。 

Install：3G-SDI オプション有り 
None：3G-SDI オプション無し 
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6. 内部設定 

6-1. ディップスイッチ S3 

UFM-30DCC 内部の FRONT CARD 上のディップスイッチ S3 により、DCC-OUA/WEB 制御

切り換え、処理モードの切り換え、初期化が可能です。 

 

 

 

 

 

 

 

 

 

 

 

 ディップスイッチ S3 設定 

番号 機能 
設定 

出荷時設定
OFF ON 

1 DCC-OUA/WEB 制御切り換え OUA WEB OFF 

2 FACTORY SET - - OFF 

3 処理モードの切り換え 互換モード 30DCC モード ON 

4 FACTORY SET - - OFF 

5 FACTORY SET - - OFF 

6 初期化 OFF ON OFF 

7 FACTORY SET - - OFF 

8 FACTORY SET - - OFF 

 

 

6-1-1. DCC-OUA/WEB 制御切り換え (S3-1) 

WEB ブラウザから制御する場合は ON に設定します。 
OFF（初期設定） DCC-OUA から制御します。 

ON WEB ブラウザおよび DCC-NETOU から制御します。(*1) (*2) 

(*1) ジャンパ設定の変更が必要です。（「6-2. ジャンパ設定」参照。） 

(*2) UFM-30CTL（別売）が必要です。 

 

 

6-1-2. 初期化方法 (S3-6) 

1) FRONT CARD 上のディップスイッチ S3-6 ピンを ON にします。 

2) UFM フレームの電源を入れ直します。ディスプレイに「Complete」と表示されると初

期化完了です。UFM-30DCC の設定が、すべて工場出荷時の設定に戻ります。 

3) ディップスイッチ S3-6 ピンを OFF に戻します。 

 

注意 ディップスイッチ S3 の他のピン設定は、変更しないでください。 

FRONT CARD REAR CARD 

S3 

8 

 ON 

1 
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6-1-3. 処理モードの切り換え(S3-3) 

UFM-30DCC の処理モードを 2 種類から選択できます。 

OFF 
従来の DCC 製品 (DCC-70HS、DCC-100、UFM-100DCC) と同様に、
カラーコレクション処理後にプロセスアンプ処理を行います。（互
換モード） 

ON（初期設定） プロセスアンプ処理後にカラーコレクション処理を行います。 

 

 UFM-30DCC ブロックダイアグラム 

＜UFM-30DCC モード(S3-3: ON)＞ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

＜DCC 互換モード(S3-3: OFF)＞ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Y 

Pr 
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Y Level

C Level

Black Level
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RGB
CLIP
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Clip 

White Clip

Black Clip

C Clip

 
CMPST 

Clip 

White Clip 

Black Clip 

Y
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Y 

Pr 

Proc 
Amp 

Video Level

Pb 

Y Level

C Level

Black Level

Hue

 
CC 

MODE 
 

RGB 
CC 

 
RGB 
CLIP 

White(R/G/B)

BAL/DIF/SEP

Black(R/G/B)
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White Clip

Black Clip

YPbPr
Clip 

White Clip

Black Clip

C Clip

 
CMPST 

Clip 

White Clip 

Black Clip 

Y

Pr

Pb
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6-2. ジャンパ JP3 

 

注意 
UFM-30DCC の REAR CARD 上の JP1 のジャンパ設定は、工場出荷時設定から

変更しないでください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 JP1、JP3 工場出荷時設定 
JP No. 工場出荷時設定 

JP1 2-3 ショート 

JP3 

1-2 ショート 

4-5 ショート 

7-8 ショート 

10-11 ショート 

※JP1 は変更しないでください。 

 

 

6-2-1. DCC-OUA/WEB 制御切り換え 

ジャンパ JP3 は、UFM-30DCC の制御方法（DCC-OUA 制御または WEB 制御）を切り換え

ます。ディップスイッチ S3-1 の変更も同時に必要です。（「6-1. ディップスイッチ S3」参

照。） 

 

DCC-OUA 制御 

 
 
 
 

WEB 制御 
(*1) 

 
 
 
 

(*1) UFM-30CTL（別売）が必要です。 

 

FRONT CARD REAR CARD 

工場出荷時設定 

JP3 

12 
 

3 

10 
 

1 

JP1 

1 3

JP3 

12

3

10

1

1-2 ショート 
4-5 ショート 
7-8 ショート 
10-11 ショート 

JP3 

12

3

10

1

2-3 ショート 
5-6 ショート 
8-9 ショート 
11-12 ショート 
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7. トラブルシューティング 
修理を依頼される前に、次のことを確認してください。 

 

注意 

下記の項目をすべて確認しても正常に動作しない場合は、製品の電源を OFF

にし、再度 ON にしてください。それでも正常に動作しない場合は、販売代理

店へご連絡ください。 

 
状況 チェック項目 対応 

前面パネルの操作がで
きない。 

ディスプレイに「Lock」
と表示されていません
か？ 

メニューコントロールを長押しして、前
面パネルのロックを解除してください。
(「4-2-2」、「5-2-7」参照) 

カラーコレクションの
設定ができない。 バイパスモードに設定さ

れていませんか？ 

Bypass/Operate 項目を Operate に変更して
ください。（「DCC-OUA 取扱説明書」、
「5-2-5」参照） ビデオクリップの設定

ができない。 

Chroma Level 項目の設
定ができない。 Correction Mode 項目が

SEPIA になっていません
か？ 

Correction Mode 項目を BALANCE または
DIF に変更してください。 Hue 項目の設定ができ

ない。 

WEB ブラウザから制
御できない。 

UFM-30CTL と正しく接
続されていますか？ 

UFM-30CTL の取扱説明書を参照し、接続
を確認してください。 

ディップスイッチ S3-1
設定 

ディップスイッチ S3-1 を ON にしてくだ
さい。（「6-1-1」参照） 

ジャンパ JP3 設定 ジャンパ JP3 を WEB制御用に設定してく
ださい。（「6-2-1」参照） 

リモートユニットから
スプリットやガンマカ
ーブなどが操作できな
い。 

DCC-OU を使用していま
せんか？ 

DCC-OU からは操作できない機能があり
ます。（「3-1-2」参照）DCC-OUA を使
用してください。 

DCC-OUA から制御で
きない。 

DCC-OUA と正しく接続
されていますか？ 

専用ケーブルを使いREMOTEコネクタか
ら DCC-OUA に接続してください。 

ディップスイッチ S3-1
設定 

ディップスイッチ S3-1をOFFにしてくだ
さい。（「6-1-1」参照） 

ジャンパ JP3 設定 ジャンパ JP3 を DCC-OUA 制御に設定し
てください。（「6-2-1」参照） 

オペレーションモード
を変更したら、前回の
値と変わっている。 

モード変更前に設定を変
更しましたか？ 

Single Channel モード、Link モード、Dual 
Channel モードの「設定 1」は共通です。
他のモードで値を変更すると、他のモー
ドでも同様に変更されます。 

イベント操作ができな
い。 

Auto Event Load 項目が
Enable になっていません
か？ 

Auto Event Load項目をDisableに変更して
ください。（「5-2-6」参照） 

Auto Event Load項目が
設定できない。 

Link モードで動作してい
ませんか？ 

Link モード時は Auto Event Load 項目は変
更できません。 

イベントを読み込んだ
ら Output Delay の値が
初期値に戻っていた。 

イベント保存時の入力ビ
デオと、現在入力してい
るビデオのフォーマット
は同じですか？ 

フォーマットが異なると、Output Delay の
値は初期値に戻る場合があります。
(「5-2-6」参照) 

Start Up Event Load を
Last Set にしていたの
に、起動したら Output 
Delay の値が初期値に
戻っていた。 

電源切断時の入力ビデオ
と、現在入力しているビ
デオのフォーマットは同
じですか？ 

フォーマットが異なると、Output Delay の
値は初期値に戻ります。(「5-2-6」参照) 
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8. 仕様および外観図 

8-1. 仕様 

 
ビデオフォーマット 1080/59.94i, 50i, 720/59.94p, 50p  

525/60, 625/50 

ビデオフォーマット  
(UFM-3DCC3G 実装
時)  

1080/50p, 59p, 60p (レベル A)  
1080/60i, 1035/59.94i, 60i 
1080/30PsF, 23.98PsF,24PsF,25PsF,29.97PsF 
1080/30p, 23.98p, 24p, 25p, 29.97p 
720/23.98p, 24p, 25p, 30p, 29.97p, 60p 
(1080/30PsF, /29.97PsF, /25PsF は、それぞれ 1080/60i, 59.94i, 50i として
扱われます。)  

ビデオ入力 3G-SDI: 3 Gbps または HD-SDI: 1.5 Gbps または SD-SDI: 270 Mbps  
75Ω BNC x 2 

ビデオ出力 3G-SDI: 3 Gbps または HD-SDI: 1.5 Gbps または SD-SDI: 270 Mbps  
75Ω BNC x 2 

コントローラ DCC-OUA  (Ver.3.00 以上) 
WEB 制御／SNMP 監視 (UFM-30CTL が必要)  
DCC-NETOU (UFM-30CTL が必要)  
※DCC-OUA と他のコントローラの同時使用はできません。  

信号処理方式 4:2:2 デジタルコンポーネント 

量子化 Y: 10 ビット、C: 10 ビット 

サンプリング周波数 3G-SDI: Y: 148 MHz C: 74 MHz  
HD-SDI: Y: 74 MHz C: 37 MHz  
SD-SDI: Y: 13.5 MHz C: 6.75 MHz 

内部プロセス 2 入力 (手動選択) 1 系統 2 出力 
2 入力 2 系統 2 出力 (オプション)  

ビデオ遅延調整 最小遅延 (SD: 200CLK/HD: 140CLK) ～最大約 1H まで設定可能  

ビデオ機能  プロセスアンプ、ビデオクリップ、フリーズ 

プロセスアンプ ビデオレベル, : 0.0%～200.0% 
Y レベル: 0.0%～200.0% 
クロマ レベル: 0.0%～200.0% 
セットアップ／ブラック レベル: -7.0%～25.0% 
ヒュー: -180.0°～+180.0° 

カラーコレクション モード: バランス、ディファレンス、セピア 

 バランス、ディファレンス 

 ・ホワイトレベル (RGB): 0.0%～200.0% (入力信号に対し)  
・ブラックレベル (RGB): 0.0%～200.0% (入力信号に対し)  
・ガンマレベル (RGB): 0.0%～200.0% (入力信号に対し)  
・ガンマカーブ: WHITE、CENTER、BLACK 

 セピア 

 ・セピアレベル: 0.0%～100.0% 
・セピアカラー: -180.0°～+180.0° 
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ビデオクリップ モード：YBR クリップ、GBR クリップ、Composite クリップ 

 YBR クリップ 
・Y LEVEL クリップ: 50.0%～109.0% 
・BLACK クリップ: -7.0%～50.0% 
・C LEVEL クリップ: 50.0%～113.0% 

 GBR クリップ 
・WHITE クリップ: 50.0%～300.0% 
・BLACK クリップ: -200.0%～50.0% 

 Composite (VBS) クリップ 
・WHITE クリップ: 50.0%～150.0% 
・BLACK クリップ: -50.0%～50.0% 

処理モード切換 
(内部設定)  

UFM30DCC モード: プロセスアンプ→カラーコレクション 

旧製品互換モード: カラーコレクション→プロセスアンプ 

分割表示機能 コレクション表示を 4 つのモードで表示可能  

アンシラリデータ制御 H ANC、V ANC それぞれ通過／非通過設定可能 

インターフェース REMOTE (RS-422): D-sub 9 ピン (メス） x 1 (インチネジ) (DCC-OUA
接続用） 

使用温度 0℃～40℃ 

使用湿度 30%～85% (結露しないこと)  

電源電圧 DC+24V UFM フレームより供給 

消費電力 約 0.8A、約 20W 

外形寸法  フロントモジュール: 106 (W) x 293.2 (D) mm 
リアモジュール: 108.5 (W) x 91.6 (D) mm 

質  量 約 0.5 kg 

消耗部品 なし 

オプション ◇UFM-3DCC3G: 3G-SDI 対応オプション 

 ◇UFM-3DCC2C: 2 チャネルオプション 

 ◇DCC-OUA: カラーコレクタ用オペレーションユニット  

 ◇DCC-NETOU: カラーコレクタ用ネットワーク 
        オペレーションユニット 

 ◇UFM-30CTL: コントロールカード 

 ◇コントロールケーブル: DCC-OUA 接続用 (PC-2076-3, 10m) 
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8-2. 外観図 

（寸法単位 mm） 
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 保証書 
型名（製品名） UFM-30DCC 

シリアル番号  

ご購入日  

保証期間 ご購入日から 1 年間 

ご購入店名  

ご住所  

TEL  

お名前  

保証期間中、通常のお取り扱いにおいて発生した故障は無料修理いたします。 
お取り扱い上の不注意、天災による損傷の場合は実費をいただきます。 
ご自分で修理・調査・改造されたものは、保証いたしかねる場合があります。 
保証期間内に故障の節は本保証書をご提示の上、ご購入店または最寄りの弊社営業所に 
ご用命ください。 
この保証書は再発行いたしませんので大切に保管してください。 

株式会社 朋栄 
本社 〒150-0013 東京都渋谷区恵比寿 3 丁目 8 番 1 号 
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